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Last Updated: February 2022 (PIX4Dmapper version 4.7.5) 

Pix4Dmapper Additional Steps for 
Processing UAS Imagery 

Introduction 
Pix4Dmapper is a photogrammetry software suite compatible with aerial drone imagery that enables 
you to define areas of interest, select processing options, add ground control points (GCPs), and create 
and edit point clouds, digital surface models (DSMs), meshes and orthomosaics. Default templates 
provide automatic processing for new projects and can be customized for more control over data and 
output product quality.  
As you work through this exercise, please refer to the Pix4Dmapper Help Documentation for additional 
information about each of the steps.  The help documentation can be found on the Pix4D website or by 
clicking the Help tab within the software interface.  

Objective 
• Add to pre-existing knowledge of Pix4Dmapper by classifying and editing point clouds. 
• Generate additional outputs such as digital terrain models (DTMs). 
• Measure distance and volume using Pix4Dmapper tools. 

Prerequisites 
• Download and unzip exercise data: Bluebird.zip. 
• Install and activate Pix4Dmapper (please see Pix4Dmapper Installation Guide for details). 

NOTE: Check your hardware specifications before beginning this exercise. Search the keyword Settings in 
your start menu, then navigate to the System tab, and then click on About. If you have less than 16GB 
RAM or a slower processor, we recommend selecting 3D Maps – Rapid/Low Res for Part 1. C. 1., rather 
than 3D Maps – Standard. This will decrease processing time. 

If you experience cursor misalignment throughout this exercise, open your File Explorer and navigate to 
your Program Files folder on the Drive you installed Pix4Dmapper. Right click on the pix4dmapper.exe 
file and in the Properties window, select the Compatibility tab. Enable Disable display scaling on high 
DPI settings and click OK. You may need to close and reopen Pix4Dmapper for the cursor to be 
recalibrated. 
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Part 1: Getting Started 
In this first part of the exercise, you will navigate the project creation wizard, which consists of five 
windows, to configure important settings and options for your Pix4Dmapper project. This section will 
acquaint you with folder directories where the project outputs will be stored, where you can manage 
the camera model’s parameters, select coordinate systems, and select your processing options 
template.  

A. Create a Project 
1. Launch Pix4Dmapper by searching Pix4Dmapper in the Start menu bar and click New Project. 
2. Name the project Bluebird and set your file directory. Make sure the radio button for New 

Project is selected and click Next.  

B. Add the imagery 
1. In the Select Images window, click on Add Images and browse to the unzipped folder for 

Bluebird in which the imagery is stored. Select all 114 images and click Open, then Next. It 
may take a moment for Pix4Dmapper to read the geotag data. 

2. Under Image Geolocation, Coordinate System, click Edit. Ensure the radio button for Known 
Coordinate System (m) is checked and then select From List to enter the correct coordinate 
system information. From the dropdown menu, search for WGS 84 / World Mercator or start 
to type it in. Select WGS 84 / World Mercator, then hit OK. Your coordinate system should 
now display as WGS 84 / World Mercator. Click OK to return to the Image Properties wizard 
window. 

3. Leave the following parameters as their default values: 
i. Geolocation Accuracy: Standard 
ii. Selected Camera Model: GRII_GRLENS_18.3_4928x3264 (RGB) 

NOTE: If your camera model is not included in Pix4Dmapper’s camera model database, or if you want to 
use internal parameters that more accurately represent your camera, you can add a calibrated camera 
model of your own to a Pix4Dmapper project. The project must include a minimum of 50 images 
containing objects at varying distances from the camera, heterogenous textures, a high amount of image 
overlap and if possible, GCPs. As the images in this exercise are georeferenced from the UAS equipment, 
we will not be placing GCPs in this exercise. However, it is possible to add your own for more accurate 
results. This can be done using Google Earth or ArcGIS Desktop. 

To add a custom camera model to your database, select Image Properties Editor under the Project tab. 
Under Selected Camera Model, click Edit. Under Camera Model, click New and enter a unique name. 
Under Camera Model Parameters, click Load Optimized Parameters. Once you have entered the camera 
model information, click Save to DB under Camera Model and then click OK. Click No for Save as default 
assignment, then click OK again. Save your project once you have entered your camera model’s 
information into Pix4Dmapper’s database.  

4. Click Next. 
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5. In the Select Output Coordinate System window, ensure that the Unit is specified as meters 
(m) and that your previously set coordinate system is displayed. 

NOTE: You can check Advanced Coordinate Options to further explore and set alternative vertical 
coordinate systems if you want to adjust the geoid height but for this exercise, we recommend using the 
default setting, EGM 96 Geoid.  

6. Click Next.  

C. Select Template 
1. Under Processing Options Template, navigate to the Standard tab, then select 3D Maps. 
2. Check Start Processing Now.  
3. Click Finish to finalize the initial project setup and begin image processing. You can expect this 

to take up to and possibly over one hour in terms of run time. 
4. When this step is complete, navigate to the Project tab and hit Save. 

NOTE: Depending on what outputs your project requires and what imagery you are loading, you can opt 
for different templates. For producing Point Clouds, DSMs, 3D Meshes and Orthomosaics from aerial 
imagery, you will select either Standard or Rapid 3D Maps. These options are also good for measuring 
volumes, digitizing houses and roads and generating contour lines. For producing Point Clouds and 3D 
Meshes from ground-based imagery, you will select either Standard or Rapid 3D Models. This option is 
good for 3D models of buildings, statues and objects and video fly-through of scenes. If you opt to use 
Standard processing for larger image files, you may want to consider running the process overnight.  

Part 2: Adding a Surface 
Adding a surface can make a 3D textured mesh or DSM more accurate in terms of representing the 
geometry of your project area or can improve aesthetic qualities of your products.  

A. Adding a Surface to Improve a 3D Textured Mesh 
1. In rayCloud, under Layers, uncheck all but Triangle Meshes. 
2. Click OK on any warning messages regarding the first time loading of your mesh products. 
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3. Navigate around your mesh and identify an object in the project area, perhaps an area within 
the waterbody that appears more uneven than it should, and that you think would be more 
accurately represented by the 3D textured mesh as a planar surface. 

NOTE: To tilt view your dense point and mesh, hold shift as you left click on your mouse or trackpad and 
move in the direction you would like to view the generated products from. Use the scroll wheel to zoom 
in and out. Left click to move horizontally. Click and hold the scroll wheel to orbit. To view all points 
within your dense point cloud, hit the View All button on the View toolbar. 

4. In the main menu, click rayCloud, then click New Surface. 
5. Click the surface of the 3D textured mesh to add the first vertex. Continue clicking the surface 

of the 3D textured mesh to add more vertices, right clicking on the last one to finish digitizing 
the surface.  
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NOTE:  If you make a mistake when placing a vertex, you have two options to correct its placement. 
Right click to stop drawing vertices, then in the rayCloud tab on the left-hand side, under Objects, right 
click on your New Surface and select Remove. You can then begin to draw your surface again. 
Otherwise, you can continue to place your vertices. When complete, navigate to your surface in the 
dense point cloud and edit the vertices that have been misplaced. Click on the vertex you want to edit. In 
the right-hand side Sidebar, the images in which the vertex is present will generate (if these do not 
display, try minimizing and reopening the Images dropdown tab). Locate and click on the correct location 
of the vertex in an image and then click Apply under the Selection dropdown. In the Images dropdown, 
confirm the new location by continuing to click on the updated location in each image. Then click Apply 
again to save your changes.  

6. Under Layers, then Objects, ensure that the name of the surface is checked. 
7. If the sidebar menu is not displayed, enable Show Sidebar under View in the main menu. 

Then, in the sidebar, locate Selection and check Use for DSM and Triangle Mesh and click 
Apply.  

8. In the main menu, under Process, click Generate 3D Textured Mesh. Click Save if prompted 
to do so. Monitor the progress bar at the bottom left of the screen for status updates, it may 
take a short while. When the process is complete the progress bar will show 3D Textured 
Mesh generated. 

9. Under Project, click Save Project. 

B. Adding a Surface to Smooth a DSM (Optional) 
1. In the View Toolbar on the left-hand side, click on Mosaic Editor. It may take a few minutes to 

initially load in the DSM and orthomosaic.  
2. In the main menu, click Mosaic Editor then View, and check Show DSM.  
3. Identify one or more parts of the project area where the DSM appears to be too noisy,  
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4. In the rayCloud tab on the left-hand side of the interface, locate the Create bar as seen in the 
following figure, and click on the end icon, New Surface. 

5. Digitize a surface around the part of the project area you have identified, as done in Part 2. A 
step 5.  

6. Under Layers, locate Objects, and ensure the new surface has been checked. 
7. In the sidebar, locate Properties and check Use for DSM and Triangle Mesh and click Apply.  
8. Under Project, click Save Project. 

C. Adding a Surface to Remove an Object from a DSM (Optional) 
1. Under View, click Mosaic Editor. 
2. Identify an object that is above the ground and irrelevant to the project. 
3. Follow Part 2. B. steps 5. through 8. to complete digitizing and saving your new surface. 
4. Under Project, click Save Project. 

Part 3: Generating an Updated DSM & DTM 
It is strongly encouraged that a dense point cloud always be classified prior to generating a DTM to 
represent the model’s terrain more accurately, which is why for this part of the exercise, we rerun step 
2., and classify the point cloud prior to generating the updated DSM and a newly generated DTM. 

A. Generating an Updated DSM & DTM 
1. Click on Processing Options on the bottom left-hand corner of the screen. Uncheck step 1.  

Initial Processing.  
2. Place a check next to step 2. Point Cloud and Mesh and navigate to Point Cloud Classification 

under the first tab, Point Cloud. Check Classify Point Cloud.  
3. Place a check next to step 3. DSM, Orthomosaic and Index and navigate to Raster DTM under 

the second tab, Additional Outputs. Check GeoTIFF, then click OK.  
4. In the Processing menu, click Start. Click OK in response to any warning messages that pop 

up. 
5. Once the processing is complete you can access the Mosaic Editor. In the main menu, under 

View, click Mosaic Editor. Wait for your DSM and orthomosaic to load by keeping watch on 
the progress bar under the Processing section at the bottom of the screen. 

6. In the main menu, under Mosaic Editor, click View then check Show DSM. As an alternative, 
select DSM from the dropdown menu under the Edit Mosaic section of the toolbar located 
under the main menu 

7. Confirm that the corresponding parts of the DSM have been derived from your new surfaces 
by inspecting the new output. 
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8. To view the DTM, click Mosaic Editor in the main menu, then View, and then click Show DTM. 
You can also confirm that the DTM represents the geometry of the ground and not above 
ground objects including structures or vegetation if you made such changes. 

9. Under Project, click Save Project.   

Part 4: Measuring Distance 
There is more than one way that measurements can be performed within Pix4Dmapper once step 2. has 
been completed. One method is to digitize a polyline in the rayCloud’s 3D environment, then mark each 
of the vertices in a sufficient number of images. Another method is to mark each of the features you 
want to serve as the polyline’s vertices, to features marked in images. Each method trades off between 
accidentally snapping vertices to incorrect features and overall processing time. To avoid snapping 
errors, be sure to select the correct features in each image – precision is key for accurate measurement 
calculations.  

A. Measuring Distance 
1. Click on rayCloud in the left-hand side menu. Under Layers, uncheck everything but Point 

Clouds. 
2. In the main menu, under View, enable Show Sidebar if it is not already showing. 
3. Locate the downed tree trunk towards the mid-south-west portion of the project area as seen 

in the following figure. 
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4. Left click on a point in the dense point cloud that represents the chosen feature. 
5. Drag the edge of the sidebar to the left so that it fills most of your screen and adjust the size 

of your image thumbnails by changing the Image Size slider.  
6. In the Images section, click New Tie Point as seen in the following figure. 

 
7. In the sidebar, minimize the Selection section to collapse the manual tie point’s (MTP) details.  
8. Place your cursor on the first image in the list and locate your feature by zooming in or out 

and panning using your scroll wheel or trackpad.   



 

 

 
 

Geospatial Technology and Applications Center   |   Pix4Dmapper: Digital Aerial Imagery |   9 

9. Click on your feature, one end of the downed tree, then locate it in the next image and click 
on it once again.  

10. In the Images section, click on Focus on Selection, the far button to the right. 
11. Mark the feature in other images in the list and then click Apply in the Selection section of 

the sidebar to save your changes. Continue until no new images display. 
12. Repeat steps 4 through 11 to create a second MTP on your other feature of interest, at the 

opposing end of the downed tree trunk.  
13. In the main menu, under rayCloud, click New Polyline.  
14. In your 3D environment, left click on your first MTP and right click on your second. Note the 

dimensions of the polyline in the sidebar as seen in the following figure. 
 

15. Under Project, click Save Project.  

Part 5: Measuring Volume 
A. Measuring Volume 

1. Under View, click Processing if your Processing menu is not already displayed, and confirm 
that step 1., step 2., and step 3. are green. Under the View tab, disable Processing and enable 
Volumes.  
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2. Locate a stockpile, an accumulated reserve of dirt or rocks, where the base of the entire pile 
is as flush with the ground as possible and does not encounter another structure. 

3. Under Volumes, click New Volume. 
4. Click on a point in the dense point cloud that is at the foot of the stockpile. Continue clicking 

points around the foot of the stockpile, right clicking on the last one to finish digitizing the 
base surface. 

NOTE: If you make a mistake when placing a vertex, you have two options to correct its placement. Right 
click to stop drawing vertices, then in the Volumes tab on the left-hand side, under Objects, hover over 
Volume 1 and hit the Delete button to start delineating your volume area again. Otherwise, you can 
continue to place your vertices. When complete, in the rayCloud tab, navigate to your volume in the 
dense point cloud and edit the vertices that have been misplaced. Click on the vertex you want to edit. In 
the right-hand side Sidebar, the images in which the vertex is present will generate (if these do not 
display, try minimizing and reopening the Images dropdown tab). Locate and click on the correct location 
of the vertex in an image and then click Apply under the Selection dropdown. In the Images dropdown, 
confirm the new location by continuing to click on the updated location in each image. Then click Apply 
again to save your changes.  

5. To compute the volume of your object in the Volumes tab, under Objects, and Volume 1, click 
Compute. 

6. Confirm that the volume measurement measures the total cut volume of the stockpile. 
7. Under Project, click Save Project.  

Conclusion: Congratulations! You have completed Pix4Dmapper Additional Steps for Processing 
UAS Imagery! In this exercise, we learned how to use Pix4Dmapper to add surfaces and 
enhance our DSM and DTM outputs from aerial imagery and measure distances and volumes. 
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Additional resources, including a few tutorials and a very helpful user forum, can be found on 
the Pix4D website. 

 
 

https://support.pix4d.com/hc/en-us/categories/360001503192
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